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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
EVB-LAN8870B-MC Evaluation Board User Guide. Items discussed in this chapter 
include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes EVB-LAN8870B-MC evaluation board as a development tool 
for the LAN8870B, 1000BASE-T1 Type B Ethernet Transceiver The manual layout is 
as follows:
• Chapter 1. “Overview” – This chapter shows a brief description of the 

EVB-LAN8870B-MC.
• Chapter 2. “Getting Started” – This chapter provides information about setup 

and operation of the EVB-LAN8870B-MC.
• Chapter 3. “Hardware Configuration” – This chapter includes information about 

the hardware configuration of the EVB-LAN8870B-MC.
• Appendix A. “Schematics” – This appendix shows the EVB-LAN8870B-MC 

schematics.
• Appendix B. “Bill of Materials” – This appendix includes the 

EVB-LAN8870B-MC Bill of Materials.
• Appendix C. “Silk Screens” – This appendix includes the EVB-LAN8870B-MC 

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 5   
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silk screen.
• Appendix D. “PIC MCU Programming” – This appendix includes information on 

programing EVB-LAN8870B-MC’s PIC18 MCU through MPLAB IDE.

CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50004032A-page 6  2025 Microchip Technology Inc. and its subsidiaries 
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WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending the Warranty Registration Card entitles users to receive new product updates. 
Interim software releases are available at the Microchip web site.

THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug 
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows Inte-
grated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and 
PIC-kit 2 and 3.
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page  7   
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CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revisions Section/Figure/Entry Correction
DS50004032A 

(12-19-25)
Initial release
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Chapter 1. Overview
1.1 INTRODUCTION
The EVB-LAN8870B-MC evaluation board is a 100BASE-T1/1000BASE-T1 (Sin-
gle-Pair Ethernet) to 100BASE-TX/1000BASE-T (Gigabit Ethernet) media converter, 
for use in evaluating the LAN8870B 100BASE-T1/1000BASE-T1 Ethernet transceiver.
The 100BASE-TX/1000BASE-T side of the EVB-LAN8870B-MC uses a LAN8830 
transceiver and a conventional RJ-45 jack with integrated magnetics. It features 
auto-negotiation and auto-crossover.
The 100BASE-T1/1000BASE-T1 side uses a LAN8870B transceiver, with all neces-
sary external filtering and isolation components and an automotive single-pair Ethernet 
connector. The LAN8870B is configured in RGMII mode, and connects to the RGMII 
interface of the LAN8830.
The Microchip LAN8870B device provides a compact, cost-effective, single-port 
100BASE-T1/1000BASE-T1 Ethernet physical layer transceiver solution compliant 
with the IEEE 802.3bw-2015 and IEEE 802.3bp-2016 specifications. The LAN8870B 
also supports extended cable reach as defined in IEEE 802.3bp-2016. The device has 
a link segment supporting up to four in-line connectors using a single twisted-pair cop-
per cable for up to at least 40 meters (referred to as link segment type B).
Software is provided to allow users to access the LAN8870B registers from a PC via 
the EVB-LAN8870B-MC’s USB port and an on-board PIC microcontroller. The board 
can be powered from either the EVB-LAN8870B-MC’s USB port, external 5V or a 5V 
power supply.
This document describes setup and use of the hardware and software. This document 
also explains how to optionally reprogram the preprogrammed on-board microcontrol-
ler. A simplified block diagram of the board is shown in Figure 1-1.

1.2 BLOCK DIAGRAM

FIGURE 1-1: BLOCK DIAGRAM
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1.3 REFERENCES
Concepts and materials available in the following documents may be helpful when 
reading this document. Visit www.microchip.com for the latest documentation.
• LAN8870 Data Sheet
• LAN8830 Data Sheet
• PIC18LF25K50 Data Sheet
• MCP1726 Data Sheet
• VMX7 Data Sheet
DS50004032A-page 10  2025 Microchip Technology Inc. and its subsidiaries 
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Chapter 2. Getting Started
2.1 INTRODUCTION
This chapter outlines the steps for setting up and using the EVB-LAN8870B-MC. It 
also provides guidelines on configuring the device with the EVB-LAN8870B-MC 
Configuration Tool Software.

2.2 PHYSICAL SETUP
The Microchip EVB-LAN8870B-MC media converter is simple to set up, as shown in 
Figure 2-1. Take note of the following guidelines:
• To configure the LAN8870B to 1000BASE-T1 and slave, J4/J5/J6 must be open 

and J3 must be closed. To configure LAN8870B to 1000BASE-T1 and master, 
J3/J4/J5/J6 must be open.

• To configure the LAN8870B to 100BASE-T1 and slave, J5/J6 must be open and 
J3/J4 must be closed. To configure LAN8870B to 100BASE-T1 and master, 
J3/J5/J6 must be open and J4 must be closed.

• The board is powered via a micro USB cable by default (no shunt on J16). Board 
can be optionally powered by either external 5V (J16 pos 2-3) or by 5V power 
supply to J9 (J16 pos 1-2). 

• A CAT5 Ethernet cable can be connected to the RJ45 jack for 
100BASE-TX/1000BASE-T.

• For 100BASE-T1/1000BASE-T1, connect the cable to sealed Ethernet connector 
J8.

• For 100BASE-T1/1000BASE-T1 connection, J8 is TE DT High-speed connector 
(TE P/N: 9-2367359-1) with Type-A keying.

FIGURE 2-1: EVAL BOARD CONNECTIONS

Note: EVB-LAN8870B-MC is in Auto-Negotiation when in Managed mode (J5
closed). 
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 11 
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The PIC checks for LAN8870 speed and adjusts the LAN8830 speed to match the 
LAN8870 speed.

2.3 EVB-LAN8870B-MC CONFIGURATION TOOL SOFTWARE
The optional EVB-LAN8870B-MC Configuration Tool Software is available to monitor 
and configure the LAN8870B transceiver. Microsoft .Net 4.5 or newer must be installed 
on the PC. The software comes as an executable (.exe) file for Windows. No installa-
tion is required. To run it, just double click on the file.
The PIC microcontroller on the board is running as a CDC device, so it sets up a serial 
communication port on the PC.
Once the software is started and the application window has opened, select the appro-
priate COM port for the evaluation board, and press the connect button as shown in 
Figure 2-2.

FIGURE 2-2: COM PORT SELECTIONS
DS50004032A-page 12  2025 Microchip Technology Inc. and its subsidiaries 



Getting Started
The initial condition is a blank form with all values filled in with zero. Press the Read 
buttons to update the registers. With a successful connection to the board, designers 
should be able to:
1. Read Clause 22 registers (see Figure 2-3).

FIGURE 2-3: CLAUSE 22 REGISTER READ

2. Read Clause 45 registers (see Figure 2-4).

FIGURE 2-4: CLAUSE 45 REGISTER READ
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 13 



EVB-LAN8870B-MC Evaluation Board User Guide
3. Easily execute single READ and WRITE commands using the controls high-
lighted in Figure 2-5. For Clause 22 registers, the set is 00. For Clause 45 regis-
ters, the set is the Clause 45 Address Location of the Clause 45 register.

FIGURE 2-5: INDIVIDUAL READ AND WRITE COMMANDS

4. Load and execute configuration scripts (see Figure 2-6).

FIGURE 2-6: CONFIGURATION LOAD AND EXECUTE
DS50004032A-page 14  2025 Microchip Technology Inc. and its subsidiaries 



Getting Started
5. Implement TC10 commands for LAN8870B Sleep Setup, Sleep, and Wake Up.

FIGURE 2-7: TC10 SLEEP AND WAKE COMMANDS

The PHY Address is copied from the general setup field (PHY Address (hex)).

The Load Script buttons allow users to load three different scripts to execute when the 
appropriate execute button is clicked. The execution of the script will be displayed 
inside the console window.
Commands supported inside the script:
• Blank Lines
• # Comment Lines
• sleep command
• r - Read command
• w45 - Write command
The script has to be in.txt format. All commands are lowercase letters. The sleep 
command is followed with a sleep time in [ms] as a decimal value.
The format for a write, of 0xA08F to CL45 Address 0x01, CL45 Register 0x808B is the 
following:
w45 01 0x80 0x8B 0xA08F

The format for a read of CL45 Address 0x1F, CL45 Register 0x0A02 for PHY with PHY 
Address of 0x15 is the following:
r 1F 0x0A 0x02 0x15
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 15 
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Here is one example of the supported commands:
w45 07 0x02 0x00 0x0000

w45 01 0x80 0x93 0x8040

w45 01 0x80 0x8B 0x0084

w45 01 0x80 0xB0 0x001F

w45 01 0x80 0x94 0x0000

r 01 0x08 0x34 0x1F

r 01 0x0A 0x00 0x1F

2.4 QUICK START
To quickly start using the board, perform the following steps:
1. If J16 is open, connect USB Micro-A cable to EVB-LAN8870B-MC USB port 

(J15).
2. If J16 position 1-2 is closed, either connect 5V power supply to J9 or connect 

USB Micro-A cable to J15.
3. If J16 position 2-3 is closed, connect 5V of an external supply to either J1 or J2 

and GND of the external power supply to either J13 or J14.
To perform any configuration changes, launch the MPLAB® X IDE software on your 
management PC and connect a PICKit™ 4 or newer PICKit to J11 (aligning pin 1).
DS50004032A-page 16  2025 Microchip Technology Inc. and its subsidiaries 
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Chapter 3. Hardware Configuration
3.1 INTRODUCTION
This chapter features the configuration options for the EVB-LAN8870B-MC as well as 
detailed information on the jumpers, headers, status LEDs, and other essential parts 
of the board.

3.2 HARDWARE CONFIGURATION OPTIONS
Figure 3-1 shows the top view of the EVB-LAN8870B-MC.

FIGURE 3-1: EVB-LAN8870B-MC (TOP VIEW)

3.2.1 Jumpers and Headers
The Section 2.4 “Quick Start” describes the basic setup of the media converter 
board. 
Descriptions of the jumpers are given in Table 3-1, and descriptions of the other head-
ers are given in Table 3-2.

TABLE 3-1: JUMPER DESCRIPTIONS 
Jumpers Description

J3 Master-Slave mode/PHYAD2 Selection. 
If J5 is open: Open - Master. Closed - Slave
If J5 is closed: Open - PHYAD2 = 1. Closed - PHYAD2 = 0

J4 Speed/PHYAD4 Selection. 
If J5 is open: Open - 1000BASE-T1. Closed - 100BASE-T1
If J5 is closed: Open - PHYAD4 = 1. Closed - PHYAD4 = 0

J5 Managed mode. Open - Autonomous mode. Closed - Managed 
mode
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 17 
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3.2.2 Status LEDs
Descriptions of the status LEDs are given in Table 3-3.

J6 Master-Slave mode/PHYAD3 Selection. 
If J5 is open: Open - Auto-Negotiation Enabled. Closed - 
Auto-Negotiation Disabled
If J5 is closed: Open - PHYAD3 = 1. Closed - PHYAD3 = 0

J9 5V Power Barrel (need J16 in Pos 1-2)
J16 Open: USB Powered.

Position 1-2: USB Powered or 5V Power Supply to J9.
Position 2-3: Ext 5V Power (Apply positive 5V on either J1 or J13 
and GND on either J2 or J14.)

TABLE 3-2: HEADER DESCRIPTIONS 
Headers Description

J1 and J13 +5V power. This is an alternative to powering the board via USB.
J2 and J14 Ground

J4 These signals are controlled by the PIC microcontroller. They 
should not be controlled externally, but they may be monitored. 
Pin 1: MDC
Pin 2: MDIO
Pin 3: LAN8830 Reset
Pin 4: LAN8870B Reset
Pin 5: Ground

J5 These signals are either controlled by the PIC microcontroller, or 
are outputs of the LAN8870B. Do not drive them externally.
Pin 1: WAKE_IN - Input to the LAN8870B.
Pin 2: INH - Output from the LAN8870B.

J11 5-pin PIC programming header
TP1 WAKE OUT Test Point
TP2 WAKE IN Test Point
TP3 INH Test Point
TP4 3.3V Power Test Point
TP5 GND Test Point

TABLE 3-3: LED DESCRIPTIONS 
LEDs Description

D1 LAN8830 Reset Indicator
D3 LAN8870B Link Indicator
D4 LAN8870B Reset Indicator
D6 3V3 Indicator
D7 PIC Programming LED (On = PIC Initialization complete)
D8 Secondary LAN8870B Link Indicator
D9 LAN8870B Master/Slave Indicator
D10 5V Indicator

TABLE 3-1: JUMPER DESCRIPTIONS 
Jumpers Description
DS50004032A-page 18  2025 Microchip Technology Inc. and its subsidiaries 
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3.2.3 100BASE-T1/1000BASE-T1 Single-Pair Ethernet Connector
The board comes with a TE DT Highspeed connector for 100BASE-T1/1000BASE-T1 
connections. The cable assemblies are TE DT high-speed connectors using Cham-
plain cable P/N 15-09066, which can be found on distributor websites such as Digikey 
and Mouser.

3.2.4 Reset Push Button
The “SW1 Reset” push button resets the PIC microcontroller, which in turn resets both 
LAN8830 and LAN8870.
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 19 
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Appendix A. Schematics
A.1 INTRODUCTION
This appendix shows the EVB-LAN8870B-MC schematic.
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Appendix B. Bill of Materials

B.1 INTRODUCTION
This appendix contains the EVB-LAN8870B-MC Bill of Materials (BOM).
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facturer Manufacturer Part Number

0603YD105KAT2A

CGA2B3X7R1V104K050BB

GRM1555C1H180JA01D

C1005X7R1H104K050BB

 North America GRM188R61E106MA73D

 North America GRM155R6YA105KE11D

GRM155R60J475ME47D

C2012X7T2E104K125AA

C0805C472KARACAUTO

 North America GRM188R6YA475KE15D

C0603C470J5GACTU

06035G104ZAT2A

LTST-C191KRKT

r MMBD914LT1G

LTST-C191KGKT

 North America BLM18EG221SN1D

MMZ1608B121CTAH0

 North America BLM18AG601SH1D

77311-118-02LF
TABLE B-1: EVB-LAN8870B-MC BILL OF MATERIALS
Item Quantity Designator Description Populated Manu

1 2 C1, C33 CAP CER 1uF 16V 10% X5R SMD 0603 YES AVX

2 19 C2, C7, C14, C17, C19, 
C20, C26, C32, C40, C43, 
C47, C49, C50, C53, C55, 
C57, C58, C59, C60

CAP CER 0.1uF 35V 10% X7R SMD 0402 YES TDK

3 4 C3, C4, C12, C13 CAP CER 18pF 50V 5% C0G SMD 0402 YES Murata 

4 21 C5, C9, C11, C16, C18, 
C22, C23, C25, C28, C29, 
C30, C36, C37, C38, C41, 
C42, C51, C56, C61, C62, 
C68

CAP CER 0.1uF 50V 10% X7R SMD 0402 YES TDK

5 3 C6, C24, C35 CAP CER 10UF 25V 20% X5R SMD 0603 YES Murata Electronics

6 8 C8, C10, C28, C34, C39, 
C45, C54, C71

CAP CER 1uF 35V 10% X5R SMD 0402 YES Murata Electronics

7 5 C15, C21, C27, C31, C44 CAP CER 4.7uF 6.3V 20% X5R SMD 0402 YES Murata

8 2 C46, C52 CAP CER 0.1uF 250V 10% X7T SMD 0805 YES TDK

10 1 C48 CAP CER 4700pF 250V 10% X7R SMD 0805 YES KEMET

11 3 C63, C65, C67 CAP CER 4.7uF 35V 10% X5R SMD 0603 YES Murata Electronics

12 2 C64, C66 CAP CER 47pF 50V 5% NP0 SMD 0603 YES KEMET

13 2 C69, C70 CAP CER 0.1uF 50V 20% Y5V SMD 0603 YES KYOCERA AVX

14 2 D1, D4 DIO RED 2V 20mA 54mcd CLEAR SMD 0603 YES Lite-On Inc

15 2 D2, D5 DIO RECT MMBD914LT1G 1V 10mA 100V SMD SOT-23-3 YES ON Semiconducto

16 6 D3, D6, D7, D8, D9, D10 DIO LED GREEN 2V 30mA 35mcd Clear SMD 0603 YES Lite-On Inc

17 4 FB1, FB2, FB3, FB10 FERRITE 220R@100MHZ 2A SMD 0603 YES Murata Electronics

18 2 FB4, FB8 FERRITE 600mA 120R SMD 0603 YES TDK

19 5 FB5, FB6, FB7, FB9, FB11 FERRITE 600R 500mA SMD 0603 YES Murata Electronics

20 4 J3, J4, J5, J6 CON HDR-2.54 Male 1x2 Gold 5.84MH TH VERT YES FCI
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L829-1J1T-43

9-2367359-1

PJ-002AH

68000-105HLF

ZX62-AB-5PA(31)

TSW-103-07-G-S

ACT1210G-800-2P-TL10

ERJ-3GEYJ102V

c RMCF0603FT100K

CRCW040210K0JNED

RC0402JR-070RL

 Product CRG0402F10K

RC0402FR-074K7L

CRCW040212K1FKEDC

RT0402BRD071KL

ERJ-2GEJ471X

 Product CRG0402F10K

RC0402FR-076K04L

RNCP1206FTD1K00

CRCW0603100KFKEAHP

ERJ-2RKF2000X

ERJ-2GE0R00X

ERJ-3EKF1001V

ERJ-2RKF2201X

ERJ-2RKF1002X

ERJ-3EKF3300V

ERJ-3EKF2201V

TA
er Manufacturer Part Number
21 1 J7 CON MODULAR JACK RJ45 10/100/1000 MAGNETICS 2xLEDs 
SHIELD TH

YES Bel-Fuse

22 1 J8 CON HDR-1.8 MALE 1X2 TIN SHROUD 7MH TH R/A YES TE Connectivity

23 1 J9 CON POWER 2mm 5.5mm SWITCH TH R/A YES CUI

24 1 J11 CON HDR-2.54 Male 1x5 Gold 5.84MH TH VERT YES FCI

25 1 J15 CON USB2.0 MICRO-AB FEMALE SMD R/A YES Hirose

26 1 J16 CON HDR-2.54 Male 1x3 AU 5.84MH TH VERT YES Samtec Inc

27 1 L1 CM CHOKE 2.4R@100kHZ 80uH SMD 3.2X2.5MM AEC-Q200 YES TDK

28 2 R1, R29 RES TKF 1k 5% 1/10W SMD 0603 YES Panasonic

29 2 R2, R30 RES TKF 100k 1% 1/10W SMD 0603 YES Stackpole Electronics In

30 3 R4, R57, R63 RES TKF 10k 5% 1/16W SMD 0402 YES Vishay

31 16 R5, R9, R10, R11, R12, 
R13, R14, R15, R16, R17, 
R19, R20, R21, R28, R69, 
R70

RES TKF 0R 1/16W SMD 0402 YES Yageo

32 9 R6, R32, R33, R34, R35, 
R43, R44, R50, R61

RES TKF 10k 1% 1/16W SMD 0402 YES TE Connectivity Passive

33 5 R7, R22, R26, R40 RES TKF 4.7k 1% 1/16W SMD 0402 YES Yageo

34 1 R18 RES TKF 12.1k 1% 1/16W SMD 0402 YES Vishay

35 14 R23, R27, R31, R36, R37, 
R38, R39, R45, R46, R47, 
R48, R49, R52, R60

RES TF 1k 0.1% 1/16W SMD 0402 YES Yageo

36 2 R24, R25 RES TKF 470R 5% 1/16W SMD 0402 YES Panasonic

37 7 R6,R32, R33, R34, R35, 
R43, R44, R50

RES TKF 10k 1% 1/16W SMD 0402 YES TE Connectivity Passive

38 1 R41 RES TKF 6.04k 1% 1/16W SMD 0402 YES Yageo

39 2 R42, R54 RES TF 1k 1% 1/2W SMD 1206 YES Stackpole Electronic Inc

40 1 R51 RES TKF 100k 1% 1/4W SMD 0603 YES Vishay

41 1 R53 RES TKF 200R 1% 1/10W SMD 0402 YES Panasonic

42 2 R55, R71 RES TKF 0R SMD 0402 AEC-Q200 YES Panasonic

43 3 R56, R65, R66 RES TKF 1k 1% 1/10W SMD 0603 YES Panasonic

44 2 R58, R59 RES TKF 2.2k 1% 1/10W SMD 0402 YES Panasonic

45 2 R62 RES TKF 10k 1% 1/10W SMD 0402 YES Panasonic

46 1 R64, R72, R73 RES TKF 330R 1% 1/10W SMD 0603 YES Panasonic

47 1 R67 RES TKF 2.2k 1% 1/10W SMD 0603 YES Panasonic

BLE B-1: EVB-LAN8870B-MC BILL OF MATERIALS (CONTINUED)
Item Quantity Designator Description Populated Manufactur
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PTS810 SJM 250 SMTR LFS

5001

ics 5003

ogy LAN8830/PSA

ogy LAN8870B-V/PUAVAO

ogy PIC18LF25K50-I/ML

ogy AC59B05A

ogy VXM7-9013-25M0000000

facturer Manufacturer Part Number
48 1 SW1 SWITCH TACT SPST 16V 50mA PTS810 SJM 250 SMTR LFS 
SMD

YES C&K Components

49 3 TP1, TP2, TP3 MISC, TEST POINT MULTI PURPOSE MINI BLACK YES Keystone

50 1 TP4 CON TP LOOP Orange TH YES Keystone Electron

51 1 U1 MCHP INTERFACE ETHERNET LAN8830 QFN-48 YES Microchip Technol

52 1 U2 MCHP INTERFACE LAN8870B 1000BASE-T1 TRANSCEIVER YES Microchip Technol

53 1 U3 MCHP MCU 8-BIT 48MHz 32kB 2kB PIC18LF25K50-I/ML QFN-28 YES Microchip Technol

54 1 U4, U5 MCHP PM-LV2 REGULATOR PCB MODULE YES Microchip Technol

55 6 Y1, Y2 MCHP CRYSTAL 25Mhz 10pF SMD L3.2W2.5H0.8 YES Microchip Technol

TABLE B-1: EVB-LAN8870B-MC BILL OF MATERIALS (CONTINUED)
Item Quantity Designator Description Populated Manu
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Appendix C. Silk Screens

C.1 INTRODUCTION
This appendix shows the top and bottom silk screen images of the EVB-LAN8870B-MC.

FIGURE C-1: EVB-LAN8870B-MC TOP SILK SCREEN IMAGE
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FIGURE C-2: EVB-LAN8870B-MC BOTTOM SILK SCREEN IMAGE
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Appendix D. PIC MCU Programming

D.1 INTRODUCTION
The EVB-LAN8870B-MC has a PIC18LF25K50 microcontroller that initializes the LAN8870B at power-on 
and provides user access to the registers via the USB interface. The PIC is already programmed, so users 
are not expected to reprogram it. However, the following instructions are provided for users who wish to 
reprogram the PIC with modified initialization code.

D.2 SETTING UP MPLAB X IDE AND MPLAB XC8 COMPILER
1. Download the latest MPLAB X IDE (6.xx) from the Microchip X IDE website.
2. Open the installer. (In Windows®, it will be in the Downloads directory.) Accept the license agreement 

and click on Next on every step to launch the installation.
3. After the installation is finished, the prompt will ask to launch additional items to install. For this, the 

XC8 Compiler is necessary, but nothing else. See Figure D-1 for items to check and then click on Fin-
ish. This will open a web page to the Microchip XC Compilers website.

FIGURE D-1: MPLAB X IDE SETUP WIZARD SCREEN
 2025 Microchip Technology Inc. and its subsidiaries DS50004032A-page 31
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4. On the Microchip XC Compilers website, download the MPLAB XC8 Compiler.
5. Open the XC8 Compiler installer (same directory as step 2 above). Accept the license agreement and 

click on Next on every step of the installation.
6. Once the installation is complete, click on Next (if activating a license, which is not necessary). Acti-

vate your license, and then click on Next.

D.3 SETTING UP PROJECT IN MPLAB X IDE
1. Open MPLAB X IDE.
2. Go to File>Open Project.
3. Navigate to the folder where UNG8424_TX_T1_Version_1_USB.X folder is located. Highlight and 

click on Open Project.

FIGURE D-2: FOLDER NAVIGATION

4. This will open the project for the 1000BASET to 1000BASET1 PIC Program. Expand the project in 
the upper left corner. The PIC is programmed with the register reads and writes in the Initial-
ize_LAN8870() function in the LAN8870.c file (double-click to open). The default programming in this 
function is to set the LAN8870B to its best interoperability with other 100BASE-T1 link partners, but 
other reads and writes can be done after the default initialization.
DS50004032A-page 32  2025 Microchip Technology Inc. and its subsidiaries
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FIGURE D-3: PROJECT SCREEN

D.4 PROGRAMMING THE PIC
1. To program the PIC microcontroller, connect the programmer to J11 on the EVB-LAN8870B-MC, with 

pin 1 of J11 lining up with pin 1 of the programmer. Note that the programmer may have additional 
lines which are not connected to the board’s J11 pins. This is acceptable.

2. Go to Production>Set Project Configuration>Customize. The window in Figure D-4 will appear. 
Choose the Hardware Tool (PICKIT4, PICKit5, etc.) and XC8 compiler. Click on Apply and then click 
on OK.

FIGURE D-4: PROJECT CONFIGURATION SCREEN
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3. Click on the green play button in the toolbar to program the PIC. 

FIGURE D-5: PROGRAMMING BUTTON IN TOOLBAR

4. Check if the bottom right window displays the following when PIC programming is successful:

FIGURE D-6: PROGRAMMING CONFIRMATION

5. On the EVB-LAN8870B-MC, press the Reset button. This will reset the PIC, which will initialize the 
LAN8870B registers.
DS50004032A-page 34  2025 Microchip Technology Inc. and its subsidiaries
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